
Reports and manuscripts
with Quarto
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What is quarto?
Open-source document format and computational
notebook system

Integrates text, code, and outout

Can create multiple different types of products
(documents, slides, websites, books)
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Why not R Markdown?
Only because quarto is newer and more featured!

Anything you already know how to do in R Markdown
you can do in quarto, and more!

All of these slides, website, etc. are all made in quarto.

If you know and love R Markdown, by all means keep
using it!
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Quarto workflow
�. Create a Quarto document

�. Write code

�. Write text

�. Repeat 2-3 in whatever order you want

�. Render repeatedly as you go
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How does it work?
You text in markdown and code in R

knitr processes the code chunks, executes the R code,
and inserts the code outputs (e.g., plots, tables) back
into the markdown document

pandoc transforms the markdown document into
various output formats
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Text and code…
# My header1

2

Some text3

4

Some *italic text*5

6

Some **bold text**7

8

- Eggs9

- Milk10

11

```{r}12

x <- 313

x14
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… becomes …
My title
Some text

Some italic text
Some bold text

Eggs

Milk
x <- 31

x2

[1] 3
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If you prefer, you can use the visual editor
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R chunks
Everything within the chunks has to be valid R1

Chunks run in order, continuously, like a single script

```{r}1

x <- 32

```3

```{r}1

x + 42

```3

[1] 7
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YAML
At the top of your Quarto document, a header written in
yaml describes options for the document

There are a ton of possible options, but importantly, this
determines the document output

---1

title: "My document"2

author: Louisa Smith3

format: html4

---5
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Output

https://quarto.org/docs/output-formats/all-formats.html
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Exercises
We’re going to focus on html output

It’s easy to transition to Word ( ) but it’s not
as good for constant re-rendering

You need a LaTeX installation for pdf ( )

I recommend 

format: docx

format: pdf

{tinytex}
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https://quarto.org/docs/reference/formats/docx.html
https://quarto.org/docs/reference/formats/pdf.html
https://yihui.org/tinytex/


Exercises
You can choose whether you want to have chunk output
show up within the document (vs. just the console) when
you are running Quarto (and RMarkdown) documents
interactively
Tools > Global options
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Exercises
Open up your epi590r-2023-in-class R project!

File > New File > Quarto Document
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Exercises
Try toggling between Source and Visual views

Toggle on and off the Outline

Click Render and look at the output
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Quarto options

1



Chunk options
In your Quarto document, you had a chunk:

#| echo: false tells knitr not to show the code within
that chunk

```{r}1

#| echo: false2

2 * 23

```4

In RMarkdown, you would have written this {r, echo = FALSE}. You can still do that
with Quarto, but it’s generally easier to read, particularly for long options (like
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Chunk options
Some of the ones I find myself using most often:

#| eval: false: Don’t evaluate this chunk! Really helpful
if you’re trying to isolate an error, or have a chunk that
takes a long time

#| error: true: Render this even if the chunk causes an
error

#| cache: true: Store the results of this chunk so that it
doesn’t need to re-run every time, as long as there are
no changes

#| warning: false: Don’t print warnings

#| message: false: Don’t print messages
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Document options
You can tell the entire document not to evaluate or print
code (so just include the text!) at the top:

Careful! YAML is really picky about spacing.

---1

title: "My document"2

author: Louisa Smith3

format: html4

execute:5

  eval: false6

  echo: false7

---8
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Document options
There are  for the document

For example, you can choose a :

Remember the pickiness: when you have a format
option, html: moves to a new line and the options are
indented 2 spaces

lots of different options

theme
---1

format:2

  html:3

    theme: yeti4

---5
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Exercises
Download the quarto document with some {gtsummary}
tables from yesterday

Change some options to hide code and output

Add another code chunk

Play with themes

Deal with errors

Add some text
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Quarto tables, figures, and
stats
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Chunks can produce figures and tables
```{r}1

#| label: tbl-one2

#| tbl-cap: "This is a great table"3

knitr::kable(mtcars)4

```5

Table 1: This is a great table

mpg cyl disp hp drat wt qsec
Mazda RX4 21.0 6 160.0 110 3.90 2.620 16.46
Mazda RX4
Wag

21.0 6 160.0 110 3.90 2.875 17.02

Datsun 710 22.8 4 108.0 93 3.85 2.320 18.6
Hornet 4
Drive

21.4 6 258.0 110 3.08 3.215 19.44



mpg cyl disp hp drat wt qsec

Hornet
Sportabout

18.7 8 360.0 175 3.15 3.440 17.02

Valiant 18.1 6 225.0 105 2.76 3.460 20.22
Duster 360 14.3 8 360.0 245 3.21 3.570 15.84
Merc 240D 24.4 4 146.7 62 3.69 3.190 20.00
Merc 230 22.8 4 140.8 95 3.92 3.150 22.90
Merc 280 19.2 6 167.6 123 3.92 3.440 18.30
Merc 280C 17.8 6 167.6 123 3.92 3.440 18.90
Merc
450SE

16.4 8 275.8 180 3.07 4.070 17.40

Merc 450SL 17.3 8 275.8 180 3.07 3.730 17.60



mpg cyl disp hp drat wt qsec
Merc
450SLC

15.2 8 275.8 180 3.07 3.780 18.00

Cadillac
Fleetwood

10.4 8 472.0 205 2.93 5.250 17.98

Lincoln
Continental

10.4 8 460.0 215 3.00 5.424 17.82

Chrysler
Imperial

14.7 8 440.0 230 3.23 5.345 17.42

Fiat 128 32.4 4 78.7 66 4.08 2.200 19.47
Honda
Civic

30.4 4 75.7 52 4.93 1.615 18.52



mpg cyl disp hp drat wt qsec
Toyota
Corolla

33.9 4 71.1 65 4.22 1.835 19.90

Toyota
Corona

21.5 4 120.1 97 3.70 2.465 20.0

Dodge
Challenger

15.5 8 318.0 150 2.76 3.520 16.87

AMC
Javelin

15.2 8 304.0 150 3.15 3.435 17.30

Camaro
Z28

13.3 8 350.0 245 3.73 3.840 15.4

Pontiac
Firebird

19.2 8 400.0 175 3.08 3.845 17.05



mpg cyl disp hp drat wt qsec
Fiat X1-9 27.3 4 79.0 66 4.08 1.935 18.90
Porsche
914-2

26.0 4 120.3 91 4.43 2.140 16.70

Lotus
Europa

30.4 4 95.1 113 3.77 1.513 16.90

Ford
Pantera L

15.8 8 351.0 264 4.22 3.170 14.50

Ferrari Dino 19.7 6 145.0 175 3.62 2.770 15.50
Maserati
Bora

15.0 8 301.0 335 3.54 3.570 14.60

Volvo 142E 21.4 4 121.0 109 4.11 2.780 18.60

2



Chunks can produce figures or tables

Figure 1: This is a histogram

```{r}1

#| label: fig-hist2

#| fig-cap: "This is a histogram"3

hist(rnorm(100))4

```5
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Cross-referencing
You can then refer to those with @tbl-one and @fig-hist
and the Table and Figure ordering will be correct (and
linked)

gets printed as:

 contains a histogram and  a table.

@fig-hist contains a histogram and @tbl-one a table.

Figure 1 Table 1
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Inline R
Along with just regular text, you can also run R code
within the text:

becomes:

There were 7 participants

There were `r 3 + 4` participants
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Inline R
This is helpful for reporting statistics, e.g. the sample size:

becomes:

There were 1.2686^{4} participants

There were `r nrow(nlsy)` participants
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Inline stats
You can also create an object in a chunk and then
reference it later in the text

```{r}1

total_sample <- nrow(nlsy)2

```3

There were `r total_sample` participants
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Inline stats (aside)
I often create a list of stats that I want to report in a
manuscript:

I can then print these numbers in the text with:

There were `r stats$n` participants with a mean age of
`r stats$mean_age`.

which turns into:
There were 1123 participants with a mean age of 43.5.

stats <- list(n = nrow(data),1

              mean_age = mean(data$age))2
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Inline stats from {gtsummary}
We saw very, very briefly yesterday:

We pulled a statistic from our univariate table

library(gtsummary)1

income_table <- tbl_uvregression(2

  nlsy,3

  y = income,4

  include = c(5

    sex_cat, race_eth_cat,6

    eyesight_cat, income, age_bir7

  ),8

  method = lm9

)10

inline_text(income_table, variable = "age_bir")1

[1] "595 (95% CI 538, 652; p<0.001)"
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If we’re making a table, we probably want
to report numbers from it

```{r}1

#| label: tbl-descr2

#| tbl-cap: "Descriptive statistics"3

#| output-location: slide4

table1 <- tbl_summary(5

  nlsy,6

  by = sex_cat,7

  include = c(sex_cat, race_eth_cat, region_cat,8

              eyesight_cat, glasses, age_bir)) |> 9

  add_overall(last = TRUE)10

table111

```12
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If we’re making a table, we probably want
to report numbers from it

Table 2: Descriptive statistics

Characteristic

Male
N = 6,403

1

Female
N = 6,283

1

Overall
N = 12,686

1

race_eth_cat

    Hispanic 1,000 (16%) 1,002 (16%) 2,002 (16%)

    Black 1,613 (25%) 1,561 (25%) 3,174 (25%)

    Non-Black, Non-Hispanic 3,790 (59%) 3,720 (59%) 7,510 (59%)

region_cat

    Northeast 1,296 (21%) 1,254 (20%) 2,550 (20%)

    North Central 1,488 (24%) 1,446 (23%) 2,934 (24%)

    South 2,251 (36%) 2,317 (38%) 4,568 (37%)

    West 1,253 (20%) 1,142 (19%) 2,395 (19%)

    Unknown 115 124 239

eyesight_cat
1

n (%); Median (Q1, Q3)



Characteristic

Male
N = 6,403

1

Female
N = 6,283

1

Overall
N = 12,686

1

    Excellent 1,582 (38%) 1,334 (31%) 2,916 (35%)

    Very good 1,470 (35%) 1,500 (35%) 2,970 (35%)

    Good 792 (19%) 1,002 (23%) 1,794 (21%)

    Fair 267 (6.4%) 365 (8.5%) 632 (7.5%)

    Poor 47 (1.1%) 85 (2.0%) 132 (1.6%)

    Unknown 2,245 1,997 4,242

glasses 1,566 (38%) 2,328 (54%) 3,894 (46%)

    Unknown 2,241 1,995 4,236

age_bir 25 (21, 29) 22 (19, 27) 23 (20, 28)

    Unknown 3,652 3,091 6,743
1

n (%); Median (Q1, Q3)
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I want to report some stats!
The help file for inline_text() is helpful and tells us that
we can look at table1$table_body to help figure out what
data to extract.

How about the median (IQR) age of the male participants
at the birth of their first child?

inline_text(table1, variable = "age_bir", column = "stat_11

[1] "25 (21, 29)"
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Formatting
We can add sample sizes for the overall stats on people
who wear glasses using the pattern = argument:

inline_text(table1, variable = "glasses", column = "stat_01

            pattern = "{n}/{N} ({p}%)")2

3,894/8450 (46%)
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Formatting for regression statistics
Remove some details:

inline_text(income_table, variable = "age_bir")1

[1] "595 (95% CI 538, 652; p<0.001)"

inline_text(income_table, variable = "age_bir",1

            pattern = "{estimate} ({conf.low}, {conf.high}2

[1] "595 (538, 652)"
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Better yet…
We can integrate these into the text of our manuscript:

Which becomes:

A greater proportion of female (2,328 (54%)) than male
(1,566 (38%)) participants wore glasses.

A greater proportion of female (`r inline_text(table1, 
variable = "glasses", column = "stat_2")`) than male 

(`r inline_text(table1, variable = "glasses", column = 
"stat_1")`) participants wore glasses.
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Readability
Because this can be hard to read, I’d suggest storing those
stats in a chunk before the text:

```{r}1

glasses_f <- inline_text(table1, variable = "glasses", 2

                         column = "stat_2")3

glasses_m <- inline_text(table1, variable = "glasses", 4

                         column = "stat_1")5

```6

A greater proportion of female (`r glasses_f`) than male (7
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Exercises
Return to the quarto document with the tables.

Choose a table to label and caption, and then write a
sentence that cross-references it (e.g., Table 1 shows the
descriptive statistics)

Edit or create a new table that has the median hours of
sleep on weekends in it (in the overall sample).

Pull that value from a table.
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Functions
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Functions in R
I’ve been denoting functions with parentheses: func()

We’ve seen functions such as:

mean()

tbl_summary()

init()

create_github_token

Functions take arguments and return values
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Looking inside a function
If you want to see the code within a function, you can just
type its name without the parentheses:

usethis::create_github_token1

function (scopes = c("repo", "user", "gist", "workflow"), description = "DESCRIBE THE TOKEN'S USE 
CASE", 
   host = NULL) 
{
   scopes <- glue_collapse(scopes, ",")
   host <- get_hosturl(host %||% default_api_url())
   url <- glue("{host}/settings/tokens/new?scopes={scopes}&description={description}")
   withr::defer(view_url(url))
   hint <- code_hint_with_host("gitcreds::gitcreds_set", host)
   message <- c(`_` = "Call {.run {hint}} to register this token in the local Git\n           
credential store.")
   if (is_linux()) {
       message <- c(message, `!` = "On Linux, it can be tricky to store credentials 
persistently.", 
           i = "Read more in the {.href ['Managing Git(Hub) Credentials' article]
(https://usethis.r-lib.org/articles/articles/git-credentials.html)}.")
   }
   message <- c(message, i = "It is also a great idea to store this token in any\n           
password-management software that you use.")



   ui_bullets(message)
   invisible()
}
<bytecode: 0x141ac26a0>
<environment: namespace:usethis>
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Structure of a function

You can name your function like you do any other object

Just avoid names of existing functions

func <- function()1
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Structure of a function

What objects/values do you need to make your function
work?

You can give them default values to use if the user
doesn’t specify others

func <- function(arg1, 1

                 arg2 = default_val)2

}3
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Structure of a function

Everything else goes within curly braces

Code in here will essentially look like any other R code,
using any inputs to your functions

func <- function(arg1, 1

                 arg2 = default_val) {2

3

} 4
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Structure of a function

One thing you’ll likely want to do is make new objects
along the way

These aren’t saved to your environment (i.e., you won’t
see them in the upper-right window) when you run the
function

You can think of them as being stored in a temporary
environment within the function

func <- function(arg1, 1

                 arg2 = default_val) {2

  new_val <- # do something with args 3

} 4
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Structure of a function

Return something new that the code has produced

The return() statement is actually optional. If you don’t
put it, it will return the last object in the code. When
you’re starting out, it’s safer to always explicitly write out
what you want to return.

func <- function(arg1, 1

                 arg2 = default_val) {2

  new_val <- # do something with args3

  return(new_val)4

} 5
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Example: a new function for the mean
Let’s say we are not satisfied with the mean() function and
want to write our own.

Here’s the general structure we’ll start with.

new_mean <- function() {1

2

}3
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New mean: arguments
We’ll want to take the mean of a vector of numbers.

It will help to make an example of such a vector to think
about what the input might look like, and to test the
function. We’ll call it x:

We can add x as an argument to our function:

x <- c(1, 3, 5, 7, 9)1

new_mean <- function(x) {1

2

}3
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New mean: function body
Let’s think about how we calculate a mean in math, and
then translate it into code:

So we need to sum the elements of x together, and then
divide by the number of elements.

=x̄
1
n∑i=1

n

xi
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We can use the functions sum() and length() to help us.

We’ll write the code with our test vector first, before
inserting it into the function:

n <- length(x)1

sum(x) / n2

[1] 5

12



New mean: function body
Our code seems to be doing what we want, so let’s insert
it. To be explicit, I’ve stored the answer (within the
function) as mean_val, then returned that value.

new_mean <- function(x) {1

  n <- length(x)2

  mean_val <- sum(x) / n3

  return(mean_val)4

}5
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Testing a function
Let’s plug in the vector that we created to test it:

And then try another one we create on the spot:

new_mean(x = x)1

[1] 5

new_mean(x = c(100, 200, 300))1

[1] 200
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Exercises
Create some functions!

Create an R script in your project called functions.R to
save your work!
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Functions, continued
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Adding another argument
Let’s say we plan to be using our new_mean() function to
calculate proportions (i.e., the mean of a binary variable).
Sometimes we’ll want to report them as as percentage by
multiplying the proportion by 100.
Let’s name our new function prop(). We’ll use the same
structure as we did with new_mean().

prop <- function(x) {1

  n <- length(x)2

  mean_val <- sum(x) / n3
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Testing the code
Now we’ll want to test on a vector of 1’s and 0’s.

To calculate the proportion and turn it into a percentage,
we’ll just multiply the mean by 100.

x <- c(0, 1, 1)1

multiplier <- 1001

multiplier * sum(x) / length2

[1] 66.66667
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Testing the code
We want to give users the option to choose between a
proportion and a percentage. So we’ll add an argument
multiplier. When we want to just return the proportion,
we can just set multiplier to be 1.

multiplier <- 11

multiplier * sum(x) / length2

[1] 0.6666667

multiplier <- 1001

multiplier * sum(x) / length2
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Adding another argument
If we add multiplier as an argument, we can refer to it in
the function body.

prop <- function(x, multipli1

  n <- length(x)2

  mean_val <- multiplier * s3

  return(mean_val)4

}5
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Adding another argument
Now we can test:

prop(x = c(1, 0, 1, 0), multiplier = 1)1

[1] 0.5

prop(x = c(1, 0, 1, 0), multiplier = 100)1

[1] 50
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Making a default argument
Since we don’t want users to have to specify multiplier = 
1 every time they just want a proportion, we can set it as a
default.

Now we only need to specify that argument if we want a
percentage.

prop <- function(x, multiplier = 1) {1

  n <- length(x)2

  mean_val <- multiplier * sum(x) / n3

  return(mean_val)4

}5

prop(x = c(0, 1, 1, 1))1

[1] 0.75

prop(x = c(0, 1, 1, 1), multiplier = 100)1



[1] 75
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Caveats
This is obviously not the best way to write this function!

For example, it will still work if x = c(123, 593, -192)….
but it certainly won’t give you a proportion or a
percentage!

We could also put multiplier = any number, and we’ll
just be multiplying the answer by that number – this is
essentially meaningless.

We also haven’t done any checking to see whether the
user is even entering numbers! We could put in better
error messages so users don’t just get an R default error
message if they do something wrong.

prop(x = c("blah", "blah", "blah"))1
8



Functions, continued
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Writing functions to reduce copy and
paste
If you find yourself doing something over and over, you
can probably write a function for it.

One is example is the regression tables we created
yesterday.

2



Let’s imagine we are fitting multiple similar
models

logistic_model <- glm(glasses ~ eyesight_cat + sex_cat + i1

  data = nlsy, family = binomial()2

)3

poisson_model <- glm(nsibs ~ eyesight_cat + sex_cat + inco4

  data = nlsy, family = poisson()5

)6

logbinomial_model <- glm(glasses ~ eyesight_cat + sex_cat 7

  data = nlsy, family = binomial(link = "log")8

)9

3



We have a model for a table we want to
create

Even though this is already a function, we can wrap it in a
new function!

tbl_regression(1

  poisson_model,2

  exponentiate = TRUE,3

  label = list(4

    sex_cat ~ "Sex",5

    eyesight_cat ~ "Eyesight",6

    income ~ "Income"7

  )8

)9
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New table function
We can refer generically to model and then put the model
we want a table for as an argument

new_table_function <- function(model) {1

  tbl_regression(2

    model,3

    exponentiate = TRUE,4

    label = list(5

      sex_cat ~ "Sex",6

      eyesight_cat ~ "Eyesight",7

      income ~ "Income"8

    )9

  )10

}11
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Exercise
Copy and paste this function into your script

Create each of the models and run

Try to figure out how you could allow someone to pass
the tidy_fun argument (from the regression exercises
yesterday)
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{renv}
Package management for R

1



What is {renv}?
{renv} is an R package for managing project
dependencies and creating reproducible environments
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Benefits of using {renv}
�. Isolation: Creates project-specific environments

separate from the global R library.

�. Reproducibility: Ensures consistent package versions
for code reproducibility.

�. Collaboration: Facilitates sharing and collaborating on
projects with others.

3



Getting Started with {renv}
�. Install {renv}

�. Initialize a project

�. Install packages

�. Track dependencies via a lockfile

install.packages("renv")1

renv::init()1

install.packages("other_package")1

# only an option when using renv!2

install.packages("github_user/github_package")3

renv::snapshot()1
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Behind the scenes
Your project .Rprofile is updated to include:

This is run every time R starts, and does some
management of the library paths to make sure when
you call install.packges("package") or
library(package) it does to the right place
(renv/library/R-{version}/{computer-specifics})

A renv.lock file (really just a text file) is created to store
the names and versions of the packages.

source("renv/activate.R")1
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renv.lock
{
  "R": {
    "Version": "4.3.0",
    "Repositories": [
      {
        "Name": "CRAN",
        "URL": "https://cran.rstudio.com"
      }
    ]
  },
  "Packages": {
    "R6": {
      "Package": "R6",
      "Version": "2.5.1",
      "Source": "Repository",
      "Repository": "CRAN",
      "Requirements": [
        "R"
      ],
      "Hash": "470851b6d5d0ac559e9d01bb352b4021"
    },
    base64enc": {
      "Package": "base64enc",
      "Version": "0.1-3",
      "Source": "Repository",
      "Repository": "CRAN",
      "Requirements": [



        "R"
      ],
      "Hash": "543776ae6848fde2f48ff3816d0628bc"
    },

6



Using {renv} later
Restore an environment

Install new packages

Update the lockfile

renv::restore()1

install.packages("other_package")1

renv::snapshot()1
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Collaboration with {renv}
Share the project’s renv.lock file with collaborators to
ensure consistent environments

When they run renv::restore(), the correct versions of
the packages will be installed on their computer

renv::restore()1
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Other helpful functions
Remove packages that are no longer used:

Check the status of the project library with respect to the
lockfile:

This will tell you to renv::snapshot() to add packages
you’ve installed but haven’t snapshotted, or
renv::restore() if you’re missing packages you need but
which aren’t installed

renv::clean()1

renv::status()1

9



Conclusion
{renv} benefits:

Isolation, reproducibility, and collaboration

Getting started with {renv}

�. Initialize a project using renv::init()

�. Install packages and store with renv::snapshot()

�. Restore later or elsewhere with renv::restore()

10



Exercises
�. Install a new R package of your choice. (Not sure what

to choose? Try one of . For example, I
did install.packages("hadley/emo").)

�. Create an R script and save it in your R project. Include
some code that requires the package. For example:

these fun packages

emo::ji("banana")1

https://medium.com/geekculture/15-fun-r-packages-you-may-not-know-of-fb25a9dcd627


�. Run renv::status() to make sure your project picked
up the package as a dependency.

�. Run renv::snapshot() to record that package in your
lockfile.

�. Open your lockfile and look for your new package. For
example, mine now has:

"emo": {
      "Package": "emo",
      "Version": "0.0.0.9000",
      "Source": "git",
      "RemoteType": "git",
      "RemoteUrl": "https://github.com/hadley/emo",
      "RemoteHost": "api.github.com",
      "RemoteUsername": "hadley",
      "RemoteRepo": "emo",
      "RemoteRef": "master",
      "RemoteSha": "3f03b11491ce3d6fc5601e210927eff73bf8e350",
      "Requirements": [
        "R",
        "assertthat",
        "crayon",
        "glue",
        "lubridate",
        "magrittr", 11



Reports and manuscripts
with Quarto

1



What is quarto?
Open-source document format and computational
notebook system

Integrates text, code, and outout

Can create multiple different types of products
(documents, slides, websites, books)

2



Why not R Markdown?
Only because quarto is newer and more featured!

Anything you already know how to do in R Markdown
you can do in quarto, and more!

All of these slides, website, etc. are all made in quarto.

If you know and love R Markdown, by all means keep
using it!

3



Quarto workflow
�. Create a Quarto document

�. Write code

�. Write text

�. Repeat 2-3 in whatever order you want

�. Render repeatedly as you go

4



How does it work?
You text in markdown and code in R

knitr processes the code chunks, executes the R code,
and inserts the code outputs (e.g., plots, tables) back
into the markdown document

pandoc transforms the markdown document into
various output formats

5



Text and code…
# My header1

2

Some text3

4

Some *italic text*5

6

Some **bold text**7

8

- Eggs9

- Milk10

11

```{r}12

x <- 313

x14

6



… becomes …
My title
Some text

Some italic text
Some bold text

Eggs

Milk
x <- 31

x2

[1] 3

7



If you prefer, you can use the visual editor

8



R chunks
Everything within the chunks has to be valid R1

Chunks run in order, continuously, like a single script

```{r}1

x <- 32

```3

```{r}1

x + 42

```3

[1] 7

9



YAML
At the top of your Quarto document, a header written in
yaml describes options for the document

There are a ton of possible options, but importantly, this
determines the document output

---1

title: "My document"2

author: Louisa Smith3

format: html4

---5

10



Output

https://quarto.org/docs/output-formats/all-formats.html

11

https://quarto.org/docs/output-formats/all-formats.html


Exercises
We’re going to focus on html output

It’s easy to transition to Word ( ) but it’s not
as good for constant re-rendering

You need a LaTeX installation for pdf ( )

I recommend 

format: docx

format: pdf

{tinytex}

12

https://quarto.org/docs/reference/formats/docx.html
https://quarto.org/docs/reference/formats/pdf.html
https://yihui.org/tinytex/


Exercises
You can choose whether you want to have chunk output
show up within the document (vs. just the console) when
you are running Quarto (and RMarkdown) documents
interactively
Tools > Global options

13



Exercises
Open up your epi590r-2023-in-class R project!

File > New File > Quarto Document

14



Exercises
Try toggling between Source and Visual views

Toggle on and off the Outline

Click Render and look at the output

15



Quarto options

1



Chunk options
In your Quarto document, you had a chunk:

#| echo: false tells knitr not to show the code within
that chunk

```{r}1

#| echo: false2

2 * 23

```4

In RMarkdown, you would have written this {r, echo = FALSE}. You can still do that
with Quarto, but it’s generally easier to read, particularly for long options (like

2



Chunk options
Some of the ones I find myself using most often:

#| eval: false: Don’t evaluate this chunk! Really helpful
if you’re trying to isolate an error, or have a chunk that
takes a long time

#| error: true: Render this even if the chunk causes an
error

#| cache: true: Store the results of this chunk so that it
doesn’t need to re-run every time, as long as there are
no changes

#| warning: false: Don’t print warnings

#| message: false: Don’t print messages
3



Document options
You can tell the entire document not to evaluate or print
code (so just include the text!) at the top:

Careful! YAML is really picky about spacing.

---1

title: "My document"2

author: Louisa Smith3

format: html4

execute:5

  eval: false6

  echo: false7

---8

4



Document options
There are  for the document

For example, you can choose a :

Remember the pickiness: when you have a format
option, html: moves to a new line and the options are
indented 2 spaces

lots of different options

theme
---1

format:2

  html:3

    theme: yeti4

---5

5

https://quarto.org/docs/reference/formats/html.html
https://quarto.org/docs/output-formats/html-themes.html


Exercises
Download the quarto document with some {gtsummary}
tables from yesterday

Change some options to hide code and output

Add another code chunk

Play with themes

Deal with errors

Add some text

6



Quarto tables, figures, and
stats

1



Chunks can produce figures and tables
```{r}1

#| label: tbl-one2

#| tbl-cap: "This is a great table"3

knitr::kable(mtcars)4

```5

Table 1: This is a great table

mpg cyl disp hp drat wt qsec
Mazda RX4 21.0 6 160.0 110 3.90 2.620 16.46
Mazda RX4
Wag

21.0 6 160.0 110 3.90 2.875 17.02

Datsun 710 22.8 4 108.0 93 3.85 2.320 18.6
Hornet 4
Drive

21.4 6 258.0 110 3.08 3.215 19.44



mpg cyl disp hp drat wt qsec

Hornet
Sportabout

18.7 8 360.0 175 3.15 3.440 17.02

Valiant 18.1 6 225.0 105 2.76 3.460 20.22
Duster 360 14.3 8 360.0 245 3.21 3.570 15.84
Merc 240D 24.4 4 146.7 62 3.69 3.190 20.00
Merc 230 22.8 4 140.8 95 3.92 3.150 22.90
Merc 280 19.2 6 167.6 123 3.92 3.440 18.30
Merc 280C 17.8 6 167.6 123 3.92 3.440 18.90
Merc
450SE

16.4 8 275.8 180 3.07 4.070 17.40

Merc 450SL 17.3 8 275.8 180 3.07 3.730 17.60



mpg cyl disp hp drat wt qsec
Merc
450SLC

15.2 8 275.8 180 3.07 3.780 18.00

Cadillac
Fleetwood

10.4 8 472.0 205 2.93 5.250 17.98

Lincoln
Continental

10.4 8 460.0 215 3.00 5.424 17.82

Chrysler
Imperial

14.7 8 440.0 230 3.23 5.345 17.42

Fiat 128 32.4 4 78.7 66 4.08 2.200 19.47
Honda
Civic

30.4 4 75.7 52 4.93 1.615 18.52



mpg cyl disp hp drat wt qsec
Toyota
Corolla

33.9 4 71.1 65 4.22 1.835 19.90

Toyota
Corona

21.5 4 120.1 97 3.70 2.465 20.0

Dodge
Challenger

15.5 8 318.0 150 2.76 3.520 16.87

AMC
Javelin

15.2 8 304.0 150 3.15 3.435 17.30

Camaro
Z28

13.3 8 350.0 245 3.73 3.840 15.4

Pontiac
Firebird

19.2 8 400.0 175 3.08 3.845 17.05



mpg cyl disp hp drat wt qsec
Fiat X1-9 27.3 4 79.0 66 4.08 1.935 18.90
Porsche
914-2

26.0 4 120.3 91 4.43 2.140 16.70

Lotus
Europa

30.4 4 95.1 113 3.77 1.513 16.90

Ford
Pantera L

15.8 8 351.0 264 4.22 3.170 14.50

Ferrari Dino 19.7 6 145.0 175 3.62 2.770 15.50
Maserati
Bora

15.0 8 301.0 335 3.54 3.570 14.60

Volvo 142E 21.4 4 121.0 109 4.11 2.780 18.60

2



Chunks can produce figures or tables

Figure 1: This is a histogram

```{r}1

#| label: fig-hist2

#| fig-cap: "This is a histogram"3

hist(rnorm(100))4

```5

3



Cross-referencing
You can then refer to those with @tbl-one and @fig-hist
and the Table and Figure ordering will be correct (and
linked)

gets printed as:

 contains a histogram and  a table.

@fig-hist contains a histogram and @tbl-one a table.

Figure 1 Table 1

4



Inline R
Along with just regular text, you can also run R code
within the text:

becomes:

There were 7 participants

There were `r 3 + 4` participants

5



Inline R
This is helpful for reporting statistics, e.g. the sample size:

becomes:

There were 1.2686^{4} participants

There were `r nrow(nlsy)` participants

6



Inline stats
You can also create an object in a chunk and then
reference it later in the text

```{r}1

total_sample <- nrow(nlsy)2

```3

There were `r total_sample` participants

7



Inline stats (aside)
I often create a list of stats that I want to report in a
manuscript:

I can then print these numbers in the text with:

There were `r stats$n` participants with a mean age of
`r stats$mean_age`.

which turns into:
There were 1123 participants with a mean age of 43.5.

stats <- list(n = nrow(data),1

              mean_age = mean(data$age))2

8



Inline stats from {gtsummary}
We saw very, very briefly yesterday:

We pulled a statistic from our univariate table

library(gtsummary)1

income_table <- tbl_uvregression(2

  nlsy,3

  y = income,4

  include = c(5

    sex_cat, race_eth_cat,6

    eyesight_cat, income, age_bir7

  ),8

  method = lm9

)10

inline_text(income_table, variable = "age_bir")1

[1] "595 (95% CI 538, 652; p<0.001)"

9



If we’re making a table, we probably want
to report numbers from it

```{r}1

#| label: tbl-descr2

#| tbl-cap: "Descriptive statistics"3

#| output-location: slide4

table1 <- tbl_summary(5

  nlsy,6

  by = sex_cat,7

  include = c(sex_cat, race_eth_cat, region_cat,8

              eyesight_cat, glasses, age_bir)) |> 9

  add_overall(last = TRUE)10

table111

```12

10



If we’re making a table, we probably want
to report numbers from it

Table 2: Descriptive statistics

Characteristic

Male
N = 6,403

1

Female
N = 6,283

1

Overall
N = 12,686

1

race_eth_cat

    Hispanic 1,000 (16%) 1,002 (16%) 2,002 (16%)

    Black 1,613 (25%) 1,561 (25%) 3,174 (25%)

    Non-Black, Non-Hispanic 3,790 (59%) 3,720 (59%) 7,510 (59%)

region_cat

    Northeast 1,296 (21%) 1,254 (20%) 2,550 (20%)

    North Central 1,488 (24%) 1,446 (23%) 2,934 (24%)

    South 2,251 (36%) 2,317 (38%) 4,568 (37%)

    West 1,253 (20%) 1,142 (19%) 2,395 (19%)

    Unknown 115 124 239

eyesight_cat
1

n (%); Median (Q1, Q3)



Characteristic

Male
N = 6,403

1

Female
N = 6,283

1

Overall
N = 12,686

1

    Excellent 1,582 (38%) 1,334 (31%) 2,916 (35%)

    Very good 1,470 (35%) 1,500 (35%) 2,970 (35%)

    Good 792 (19%) 1,002 (23%) 1,794 (21%)

    Fair 267 (6.4%) 365 (8.5%) 632 (7.5%)

    Poor 47 (1.1%) 85 (2.0%) 132 (1.6%)

    Unknown 2,245 1,997 4,242

glasses 1,566 (38%) 2,328 (54%) 3,894 (46%)

    Unknown 2,241 1,995 4,236

age_bir 25 (21, 29) 22 (19, 27) 23 (20, 28)

    Unknown 3,652 3,091 6,743
1

n (%); Median (Q1, Q3)

11



I want to report some stats!
The help file for inline_text() is helpful and tells us that
we can look at table1$table_body to help figure out what
data to extract.

How about the median (IQR) age of the male participants
at the birth of their first child?

inline_text(table1, variable = "age_bir", column = "stat_11

[1] "25 (21, 29)"

12



Formatting
We can add sample sizes for the overall stats on people
who wear glasses using the pattern = argument:

inline_text(table1, variable = "glasses", column = "stat_01

            pattern = "{n}/{N} ({p}%)")2

3,894/8450 (46%)

13



Formatting for regression statistics
Remove some details:

inline_text(income_table, variable = "age_bir")1

[1] "595 (95% CI 538, 652; p<0.001)"

inline_text(income_table, variable = "age_bir",1

            pattern = "{estimate} ({conf.low}, {conf.high}2

[1] "595 (538, 652)"

14



Better yet…
We can integrate these into the text of our manuscript:

Which becomes:

A greater proportion of female (2,328 (54%)) than male
(1,566 (38%)) participants wore glasses.

A greater proportion of female (`r inline_text(table1, 
variable = "glasses", column = "stat_2")`) than male 

(`r inline_text(table1, variable = "glasses", column = 
"stat_1")`) participants wore glasses.

15



Readability
Because this can be hard to read, I’d suggest storing those
stats in a chunk before the text:

```{r}1

glasses_f <- inline_text(table1, variable = "glasses", 2

                         column = "stat_2")3

glasses_m <- inline_text(table1, variable = "glasses", 4

                         column = "stat_1")5

```6

A greater proportion of female (`r glasses_f`) than male (7

16



Exercises
Return to the quarto document with the tables.

Choose a table to label and caption, and then write a
sentence that cross-references it (e.g., Table 1 shows the
descriptive statistics)

Edit or create a new table that has the median hours of
sleep on weekends in it (in the overall sample).

Pull that value from a table.

17



Functions

1



Functions in R
I’ve been denoting functions with parentheses: func()

We’ve seen functions such as:

mean()

tbl_summary()

init()

create_github_token

Functions take arguments and return values

2



Looking inside a function
If you want to see the code within a function, you can just
type its name without the parentheses:

usethis::create_github_token1

function (scopes = c("repo", "user", "gist", "workflow"), description = "DESCRIBE THE TOKEN'S USE 
CASE", 
   host = NULL) 
{
   scopes <- glue_collapse(scopes, ",")
   host <- get_hosturl(host %||% default_api_url())
   url <- glue("{host}/settings/tokens/new?scopes={scopes}&description={description}")
   withr::defer(view_url(url))
   hint <- code_hint_with_host("gitcreds::gitcreds_set", host)
   message <- c(`_` = "Call {.run {hint}} to register this token in the local Git\n           
credential store.")
   if (is_linux()) {
       message <- c(message, `!` = "On Linux, it can be tricky to store credentials 
persistently.", 
           i = "Read more in the {.href ['Managing Git(Hub) Credentials' article]
(https://usethis.r-lib.org/articles/articles/git-credentials.html)}.")
   }
   message <- c(message, i = "It is also a great idea to store this token in any\n           
password-management software that you use.")



   ui_bullets(message)
   invisible()
}
<bytecode: 0x141ac26a0>
<environment: namespace:usethis>

3



Structure of a function

You can name your function like you do any other object

Just avoid names of existing functions

func <- function()1

4



Structure of a function

What objects/values do you need to make your function
work?

You can give them default values to use if the user
doesn’t specify others

func <- function(arg1, 1

                 arg2 = default_val)2

}3

5



Structure of a function

Everything else goes within curly braces

Code in here will essentially look like any other R code,
using any inputs to your functions

func <- function(arg1, 1

                 arg2 = default_val) {2

3

} 4

6



Structure of a function

One thing you’ll likely want to do is make new objects
along the way

These aren’t saved to your environment (i.e., you won’t
see them in the upper-right window) when you run the
function

You can think of them as being stored in a temporary
environment within the function

func <- function(arg1, 1

                 arg2 = default_val) {2

  new_val <- # do something with args 3

} 4

7



Structure of a function

Return something new that the code has produced

The return() statement is actually optional. If you don’t
put it, it will return the last object in the code. When
you’re starting out, it’s safer to always explicitly write out
what you want to return.

func <- function(arg1, 1

                 arg2 = default_val) {2

  new_val <- # do something with args3

  return(new_val)4

} 5

8



Example: a new function for the mean
Let’s say we are not satisfied with the mean() function and
want to write our own.

Here’s the general structure we’ll start with.

new_mean <- function() {1

2

}3

9



New mean: arguments
We’ll want to take the mean of a vector of numbers.

It will help to make an example of such a vector to think
about what the input might look like, and to test the
function. We’ll call it x:

We can add x as an argument to our function:

x <- c(1, 3, 5, 7, 9)1

new_mean <- function(x) {1

2

}3

10



New mean: function body
Let’s think about how we calculate a mean in math, and
then translate it into code:

So we need to sum the elements of x together, and then
divide by the number of elements.

=x
1
n∑i=1

n

xi

11



We can use the functions sum() and length() to help us.

We’ll write the code with our test vector first, before
inserting it into the function:

n <- length(x)1

sum(x) / n2

[1] 5

12



New mean: function body
Our code seems to be doing what we want, so let’s insert
it. To be explicit, I’ve stored the answer (within the
function) as mean_val, then returned that value.

new_mean <- function(x) {1

  n <- length(x)2

  mean_val <- sum(x) / n3

  return(mean_val)4

}5

13



Testing a function
Let’s plug in the vector that we created to test it:

And then try another one we create on the spot:

new_mean(x = x)1

[1] 5

new_mean(x = c(100, 200, 300))1

[1] 200

14



Exercises
Create some functions!

Create an R script in your project called functions.R to
save your work!

15



Functions, continued

1



Adding another argument
Let’s say we plan to be using our new_mean() function to
calculate proportions (i.e., the mean of a binary variable).
Sometimes we’ll want to report them as as percentage by
multiplying the proportion by 100.
Let’s name our new function prop(). We’ll use the same
structure as we did with new_mean().

prop <- function(x) {1

  n <- length(x)2

  mean_val <- sum(x) / n3

2



Testing the code
Now we’ll want to test on a vector of 1’s and 0’s.

To calculate the proportion and turn it into a percentage,
we’ll just multiply the mean by 100.

x <- c(0, 1, 1)1

multiplier <- 1001

multiplier * sum(x) / length2

[1] 66.66667

3



Testing the code
We want to give users the option to choose between a
proportion and a percentage. So we’ll add an argument
multiplier. When we want to just return the proportion,
we can just set multiplier to be 1.

multiplier <- 11

multiplier * sum(x) / length2

[1] 0.6666667

multiplier <- 1001

multiplier * sum(x) / length2

4



Adding another argument
If we add multiplier as an argument, we can refer to it in
the function body.

prop <- function(x, multipli1

  n <- length(x)2

  mean_val <- multiplier * s3

  return(mean_val)4

}5

5



Adding another argument
Now we can test:

prop(x = c(1, 0, 1, 0), multiplier = 1)1

[1] 0.5

prop(x = c(1, 0, 1, 0), multiplier = 100)1

[1] 50

6



Making a default argument
Since we don’t want users to have to specify multiplier = 
1 every time they just want a proportion, we can set it as a
default.

Now we only need to specify that argument if we want a
percentage.

prop <- function(x, multiplier = 1) {1

  n <- length(x)2

  mean_val <- multiplier * sum(x) / n3

  return(mean_val)4

}5

prop(x = c(0, 1, 1, 1))1

[1] 0.75

prop(x = c(0, 1, 1, 1), multiplier = 100)1



[1] 75

7



Caveats
This is obviously not the best way to write this function!

For example, it will still work if x = c(123, 593, -192)….
but it certainly won’t give you a proportion or a
percentage!

We could also put multiplier = any number, and we’ll
just be multiplying the answer by that number – this is
essentially meaningless.

We also haven’t done any checking to see whether the
user is even entering numbers! We could put in better
error messages so users don’t just get an R default error
message if they do something wrong.

prop(x = c("blah", "blah", "blah"))1
8



Functions, continued

1



Writing functions to reduce copy and
paste
If you find yourself doing something over and over, you
can probably write a function for it.

One is example is the regression tables we created
yesterday.

2



Let’s imagine we are fitting multiple similar
models

logistic_model <- glm(glasses ~ eyesight_cat + sex_cat + i1

  data = nlsy, family = binomial()2

)3

poisson_model <- glm(nsibs ~ eyesight_cat + sex_cat + inco4

  data = nlsy, family = poisson()5

)6

logbinomial_model <- glm(glasses ~ eyesight_cat + sex_cat 7

  data = nlsy, family = binomial(link = "log")8

)9

3



We have a model for a table we want to
create

Even though this is already a function, we can wrap it in a
new function!

tbl_regression(1

  poisson_model,2

  exponentiate = TRUE,3

  label = list(4

    sex_cat ~ "Sex",5

    eyesight_cat ~ "Eyesight",6

    income ~ "Income"7

  )8

)9

4



New table function
We can refer generically to model and then put the model
we want a table for as an argument

new_table_function <- function(model) {1

  tbl_regression(2

    model,3

    exponentiate = TRUE,4

    label = list(5

      sex_cat ~ "Sex",6

      eyesight_cat ~ "Eyesight",7

      income ~ "Income"8

    )9

  )10

}11

5



Exercise
Copy and paste this function into your script

Create each of the models and run

Try to figure out how you could allow someone to pass
the tidy_fun argument (from the regression exercises
yesterday)

6



{renv}
Package management for R

1



What is {renv}?
{renv} is an R package for managing project
dependencies and creating reproducible environments

2



Benefits of using {renv}
�. Isolation: Creates project-specific environments

separate from the global R library.

�. Reproducibility: Ensures consistent package versions
for code reproducibility.

�. Collaboration: Facilitates sharing and collaborating on
projects with others.

3



Getting Started with {renv}
�. Install {renv}

�. Initialize a project

�. Install packages

�. Track dependencies via a lockfile

install.packages("renv")1

renv::init()1

install.packages("other_package")1

# only an option when using renv!2

install.packages("github_user/github_package")3

renv::snapshot()1

4



Behind the scenes
Your project .Rprofile is updated to include:

This is run every time R starts, and does some
management of the library paths to make sure when
you call install.packges("package") or
library(package) it does to the right place
(renv/library/R-{version}/{computer-specifics})

A renv.lock file (really just a text file) is created to store
the names and versions of the packages.

source("renv/activate.R")1

5



renv.lock
{
  "R": {
    "Version": "4.3.0",
    "Repositories": [
      {
        "Name": "CRAN",
        "URL": "https://cran.rstudio.com"
      }
    ]
  },
  "Packages": {
    "R6": {
      "Package": "R6",
      "Version": "2.5.1",
      "Source": "Repository",
      "Repository": "CRAN",
      "Requirements": [
        "R"
      ],
      "Hash": "470851b6d5d0ac559e9d01bb352b4021"
    },
    base64enc": {
      "Package": "base64enc",
      "Version": "0.1-3",
      "Source": "Repository",
      "Repository": "CRAN",
      "Requirements": [



        "R"
      ],
      "Hash": "543776ae6848fde2f48ff3816d0628bc"
    },

6



Using {renv} later
Restore an environment

Install new packages

Update the lockfile

renv::restore()1

install.packages("other_package")1

renv::snapshot()1

7



Collaboration with {renv}
Share the project’s renv.lock file with collaborators to
ensure consistent environments

When they run renv::restore(), the correct versions of
the packages will be installed on their computer

renv::restore()1

8



Other helpful functions
Remove packages that are no longer used:

Check the status of the project library with respect to the
lockfile:

This will tell you to renv::snapshot() to add packages
you’ve installed but haven’t snapshotted, or
renv::restore() if you’re missing packages you need but
which aren’t installed

renv::clean()1

renv::status()1

9



Conclusion
{renv} benefits:

Isolation, reproducibility, and collaboration

Getting started with {renv}

�. Initialize a project using renv::init()

�. Install packages and store with renv::snapshot()

�. Restore later or elsewhere with renv::restore()

10



Exercises
�. Install a new R package of your choice. (Not sure what

to choose? Try one of . For example, I
did install.packages("hadley/emo").)

�. Create an R script and save it in your R project. Include
some code that requires the package. For example:

these fun packages

emo::ji("banana")1

https://medium.com/geekculture/15-fun-r-packages-you-may-not-know-of-fb25a9dcd627


�. Run renv::status() to make sure your project picked
up the package as a dependency.

�. Run renv::snapshot() to record that package in your
lockfile.

�. Open your lockfile and look for your new package. For
example, mine now has:

"emo": {
      "Package": "emo",
      "Version": "0.0.0.9000",
      "Source": "git",
      "RemoteType": "git",
      "RemoteUrl": "https://github.com/hadley/emo",
      "RemoteHost": "api.github.com",
      "RemoteUsername": "hadley",
      "RemoteRepo": "emo",
      "RemoteRef": "master",
      "RemoteSha": "3f03b11491ce3d6fc5601e210927eff73bf8e350",
      "Requirements": [
        "R",
        "assertthat",
        "crayon",
        "glue",
        "lubridate",
        "magrittr", 11



Reports and manuscripts
with Quarto

1



What is quarto?
Open-source document format and computational
notebook system

Integrates text, code, and outout

Can create multiple different types of products
(documents, slides, websites, books)

2



Why not R Markdown?
Only because quarto is newer and more featured!

Anything you already know how to do in R Markdown
you can do in quarto, and more!1

All of these slides, website, etc. are all made in quarto.

If you know and love R Markdown, by all means keep
using it!

�. Slight caveat…
3



Quarto workflow
�. Create a Quarto document

�. Write code

�. Write text

�. Repeat 2-3 in whatever order you want

�. Render

4



How does it work?
You text in markdown and code in R

knitr processes the code chunks, executes the R code,
and inserts the code outputs (e.g., plots, tables) back
into the markdown document

pandoc transforms the markdown document into
various output formats

5



Text and code…
# My header1

2

Some text3

4

Some *italic text*5

6

Some **bold text**7

8

- Eggs9

- Milk10

11

```{r}12

x <- 313

x14

6



… becomes …
My title
Some text

Some italic text
Some bold text

Eggs

Milk
x <- 31

x2

[1] 3

7



If you prefer, you can use the visual editor

8



R chunks
Everything within the chunks has to be valid R1

Chunks run in order, continuously, like a single script

```{r}1

x <- 32

```3

```{r}1

x + 42

```3

[1] 7

�. You can also use other languages, like Python!
9



YAML
At the top of your Quarto document, a header written in
yaml describes options for the document

There are a ton of possible options, but importantly, this
determines the document output

---1

title: "My document"2

author: Louisa Smith3

format: html4

---5

10



Output

https://quarto.org/docs/output-formats/all-formats.html

11

https://quarto.org/docs/output-formats/all-formats.html


Exercises
We’re going to focus on html output

It’s easy to transition to Word ( ) but it’s not
as good for constant re-rendering

You need a LaTeX installation for pdf

I recommend 

format: docx

{tinytex}

12

https://quarto.org/docs/reference/formats/docx.html
https://yihui.org/tinytex/


Exercises
You can choose whether you want to have chunk output
show up within the document (vs. just the console) when
you are running Quarto (and RMarkdown) documents
interactively

Tools > Global options

13



Exercises
Open up your epi590r-2023-in-class R project!

File > New File > Quarto Document

14



Exercises
Try toggling between Source and Visual views

Toggle on and off the Outline

Click Render and look at the output

15





Quarto options

1



Chunk options
In your Quarto document, you had a chunk:

#| echo: false tells knitr not to show the code within
that chunk

```{r}1

#| echo: false2

2 * 23

```4

In RMarkdown, you would have written this {r, echo = FALSE}. You can still do that
with Quarto, but it’s generally easier to read, particularly for long options (like

2



Chunk options
Some of the ones I find myself using most often:

#| eval: false: Don’t evaluate this chunk! Really helpful
if you’re trying to isolate an error, or have a chunk that
takes a long time

#| error: true: Render this even if the chunk causes an
error

#| cache: true: Store the results of this chunk so that it
doesn’t need to re-run every time, as long as there are
no changes

#| warning: false: Don’t print warnings

#| message: false: Don’t print messages
3



Document options
You can tell the entire document not to evaluate or print
code (so just include the text!) at the top:

Careful! YAML is really picky about spacing.

---1

title: "My document"2

author: Louisa Smith3

format: html4

execute:5

  eval: false6

  echo: false7

---8

4



Document options
There are  for the document

For example, you can choose a :

Remember the pickiness: when you have a format
option, html: moves to a new line and the options are
indented 2 spaces

lots of different options

theme
---1

format:2

  html:3

    theme: yeti4

---5

5

https://quarto.org/docs/reference/formats/html.html
https://quarto.org/docs/output-formats/html-themes.html


Exercises
Download the quarto document with some {gtsummary}
tables from yesterday

There’s an error in the code! Try to render it. Play around
with eval: and error: chunk and document options to
help you a) find the error and b) render the document
despite the error. Then fix the error.

I don’t like the output from the first chunk, where the
passages are loaded. Make it so that we don’t see this
chunk’s code or output.

Play around with themes!

6





Quarto tables, figures, and
stats

1



Chunks can produce figures and tables
```{r}1

#| label: tbl-one2

#| tbl-cap: "This is a great table"3

knitr::kable(mtcars)4

```5

Table 1: This is a great table

mpg cyl disp hp drat wt qsec
Mazda RX4 21.0 6 160.0 110 3.90 2.620 16.46
Mazda RX4
Wag

21.0 6 160.0 110 3.90 2.875 17.02

Datsun 710 22.8 4 108.0 93 3.85 2.320 18.6



mpg cyl disp hp drat wt qsec
Hornet 4
Drive

21.4 6 258.0 110 3.08 3.215 19.44

Hornet
Sportabout

18.7 8 360.0 175 3.15 3.440 17.02

Valiant 18.1 6 225.0 105 2.76 3.460 20.22
Duster 360 14.3 8 360.0 245 3.21 3.570 15.84
Merc 240D 24.4 4 146.7 62 3.69 3.190 20.00
Merc 230 22.8 4 140.8 95 3.92 3.150 22.90
Merc 280 19.2 6 167.6 123 3.92 3.440 18.30
Merc 280C 17.8 6 167.6 123 3.92 3.440 18.90
Merc
450SE

16.4 8 275.8 180 3.07 4.070 17.40



mpg cyl disp hp drat wt qsec
Merc 450SL 17.3 8 275.8 180 3.07 3.730 17.60
Merc
450SLC

15.2 8 275.8 180 3.07 3.780 18.00

Cadillac
Fleetwood

10.4 8 472.0 205 2.93 5.250 17.98

Lincoln
Continental

10.4 8 460.0 215 3.00 5.424 17.82

Chrysler
Imperial

14.7 8 440.0 230 3.23 5.345 17.42

Fiat 128 32.4 4 78.7 66 4.08 2.200 19.47
Honda
Civic

30.4 4 75.7 52 4.93 1.615 18.52



mpg cyl disp hp drat wt qsec
Toyota
Corolla

33.9 4 71.1 65 4.22 1.835 19.90

Toyota
Corona

21.5 4 120.1 97 3.70 2.465 20.0

Dodge
Challenger

15.5 8 318.0 150 2.76 3.520 16.87

AMC
Javelin

15.2 8 304.0 150 3.15 3.435 17.30

Camaro
Z28

13.3 8 350.0 245 3.73 3.840 15.4

Pontiac
Firebird

19.2 8 400.0 175 3.08 3.845 17.05



mpg cyl disp hp drat wt qsec
Fiat X1-9 27.3 4 79.0 66 4.08 1.935 18.90
Porsche
914-2

26.0 4 120.3 91 4.43 2.140 16.70

Lotus
Europa

30.4 4 95.1 113 3.77 1.513 16.90

Ford
Pantera L

15.8 8 351.0 264 4.22 3.170 14.50

Ferrari Dino 19.7 6 145.0 175 3.62 2.770 15.50
Maserati
Bora

15.0 8 301.0 335 3.54 3.570 14.60

Volvo 142E 21.4 4 121.0 109 4.11 2.780 18.60

2



Chunks can produce figures or tables

Figure 1: This is a histogram

```{r}1

#| label: fig-hist2

#| fig-cap: "This is a histogram"3

hist(rnorm(100))4

```5

3



Cross-referencing
You can then refer to those with @tbl-one and @fig-hist
and the Table and Figure ordering will be correct (and
linked)

gets printed as:

 contains a histogram and  a table.

@fig-hist contains a histogram and @tbl-one a table.

Figure 1 Table 1

There are currently some bugs with cross-referencing in Word docs which will be
4



Inline R
Along with just regular text, you can also run R code
within the text:

becomes:

There were 7 participants

There were `r 3 + 4` participants

5



Inline stats
I often create a list of stats that I want to report in a
manuscript:

I can then print these numbers in the text with:

There were `r stats$n` participants with a mean age of
`r stats$mean_age`.

which turns into:

There were 1123 participants with a mean age of 43.5.

stats <- list(n = nrow(data),1

              mean_age = mean(data$age))2

6



Inline stats from {gtsummary}
We saw very, very briefly yesterday:

We pulled a statistic from our univariate table

inline_text(income_table, variable = "age_bir")1

[1] "595 (95% CI 538, 652; p<0.001)"

7



If we’re making a table, we probably want
to report numbers from it

```{r}1

#| label: tbl-descr2

#| tbl-cap: "Descriptive statistics"3

#| output-location: slide4

table1 <- tbl_summary(5

  nlsy,6

  by = sex_cat,7

  include = c(sex_cat, race_eth_cat, region_cat,8

              eyesight_cat, glasses, age_bir)) |> 9

  add_overall(last = TRUE)10

table111

```12

8



If we’re making a table, we probably want
to report numbers from it

Table 2:
Descriptive statistics

Characteristic Male, N = 6,403
1
Female, N = 6,283

1
Overall, N = 12,686

1

race_eth_cat

    Hispanic 1,000 (16%) 1,002 (16%) 2,002 (16%)

    Black 1,613 (25%) 1,561 (25%) 3,174 (25%)

    Non-Black, Non-Hispanic 3,790 (59%) 3,720 (59%) 7,510 (59%)

region_cat

    Northeast 1,296 (21%) 1,254 (20%) 2,550 (20%)

    North Central 1,488 (24%) 1,446 (23%) 2,934 (24%)

    South 2,251 (36%) 2,317 (38%) 4,568 (37%)

    West 1,253 (20%) 1,142 (19%) 2,395 (19%)

    Unknown 115 124 239

eyesight_cat

    Excellent 1,582 (38%) 1,334 (31%) 2,916 (35%)

    Very good 1,470 (35%) 1,500 (35%) 2,970 (35%)

1
 n (%); Median (IQR)



Characteristic Male, N = 6,403
1
Female, N = 6,283

1
Overall, N = 12,686

1

    Good 792 (19%) 1,002 (23%) 1,794 (21%)

    Fair 267 (6.4%) 365 (8.5%) 632 (7.5%)

    Poor 47 (1.1%) 85 (2.0%) 132 (1.6%)

    Unknown 2,245 1,997 4,242

glasses 1,566 (38%) 2,328 (54%) 3,894 (46%)

    Unknown 2,241 1,995 4,236

age_bir 25 (21, 29) 22 (19, 27) 23 (20, 28)

    Unknown 3,652 3,091 6,743

1
 n (%); Median (IQR)

9



I want to report some stats!
How about the median (IQR) age of the male participants
at the birth of their first child?

Or the frequency and percentage of women from the
South?

And the overall stats on people who wear glasses?

inline_text(table1, variable = "age_bir", column = "Male")1

[1] "25 (21, 29)"

inline_text(table1, variable = "region_cat", level = "South", colu1

[1] "2,317 (38%)"

inline_text(table1, variable = "glasses", column = "stat_0",1

            pattern = "{n}/{N} ({p}%)")2

10



Better yet…
We can integrate these into the text of our manuscript:

Which becomes:

A greater proportion of female (2,328 (54%)) than male
(1,566 (38%)) participants wore glasses.

A greater proportion of female (`r inline_text(table1, 
variable = "glasses", column = "Female")`) than male 

(`r inline_text(table1, variable = "glasses", column = 
"Male")`) participants wore glasses.

11



Readability
Because this can be hard to read, I’d suggest storing those
stats in a chunk before the text:

```{r}1

glasses_f <- inline_text(table1, variable = "glasses", 2

                         column = "Female")3

glasses_m <- inline_text(table1, variable = "glasses", 4

                         column = "Male")5

```6

A greater proportion of female (`r glasses_f`) than male (`r glass7

12



Exercises
Return to the quarto document with the tables.

Choose a table to label and caption, and then write a
sentence that cross-references it (e.g., Table 1 shows the
descriptive statistics)

From that table, choose at least two statistics to pull out
of the table and include in the text using inline_text().

Add another statistic to the text that you calculate
yourself using the nlsy data, e.g., the mean number of
hours of sleep on weekends.

13





{renv}
Package management for R

1



What is {renv}?
{renv} is an R package for managing project
dependencies and creating reproducible environments

2



Benefits of using {renv}
�. Isolation: Creates project-specific environments

separate from the global R library.

�. Reproducibility: Ensures consistent package versions
for code reproducibility.

�. Collaboration: Facilitates sharing and collaborating on
projects with others.

3



Getting Started with {renv}
�. Install {renv}

�. Initialize a project

�. Install packages

�. Track dependencies via a lockfile

install.packages("renv")1

renv::init()1

install.packages("other_package")1

# only an option when using renv!2

install.packages("github_user/github_package")3

renv::snapshot()1

4



Behind the scenes
Your project .Rprofile is updated to include:

This is run every time R starts, and does some
management of the library paths to make sure when
you call install.packges("package") or
library(package) it does to the right place
(renv/library/R-{version}/{computer-specifics})

A renv.lock file (really just a text file) is created to store
the names and versions of the packages.

source("renv/activate.R")1

5



renv.lock
{
  "R": {
    "Version": "4.3.0",
    "Repositories": [
      {
        "Name": "CRAN",
        "URL": "https://cran.rstudio.com"
      }
    ]
  },
  "Packages": {
    "R6": {
      "Package": "R6",
      "Version": "2.5.1",
      "Source": "Repository",
      "Repository": "CRAN",
      "Requirements": [
        "R"
      ],
      "Hash": "470851b6d5d0ac559e9d01bb352b4021"
    },
    base64enc": {
      "Package": "base64enc",
      "Version": "0.1-3",
      "Source": "Repository",
      "Repository": "CRAN",
      "Requirements": [



        "R"
      ],
      "Hash": "543776ae6848fde2f48ff3816d0628bc"
    },

6



Using {renv} later
Restore an environment

Install new packages

Update the lockfile

renv::restore()1

install.packages("other_package")1

renv::snapshot()1

7



Collaboration with {renv}
Share the project’s renv.lock file with collaborators to
ensure consistent environments

When they run renv::restore(), the correct versions of
the packages will be installed on their computer
renv::restore()1

8



Other helpful functions
Remove packages that are no longer used:

Check the status of the project library with respect to the
lockfile:

This will tell you to renv::snapshot() to add packages
you’ve installed but haven’t snapshotted, or
renv::restore() if you’re missing packages you need but
which aren’t installed

renv::clean()1

renv::status()1

9



Conclusion
{renv} benefits:

Isolation, reproducibility, and collaboration

Getting started with {renv}

�. Initialize a project using renv::init()

�. Install packages and store with renv::snapshot()

�. Restore later or elsewhere with renv::restore()

10



Exercises
�. Install a new R package of your choice. (Not sure what

to choose? Try one of . For example, I
did install.packages("hadley/emo").)

�. Create an R script and save it in your R project. Include
some code that requires the package. For example:

these fun packages

emo::ji("banana")1

https://medium.com/geekculture/15-fun-r-packages-you-may-not-know-of-fb25a9dcd627


�. Run renv::status() to make sure your project picked
up the package as a dependency.

�. Run renv::snapshot() to record that package in your
lockfile.

�. Open your lockfile and look for your new package. For
example, mine now has:

"emo": {
      "Package": "emo",
      "Version": "0.0.0.9000",
      "Source": "git",
      "RemoteType": "git",
      "RemoteUrl": "https://github.com/hadley/emo",
      "RemoteHost": "api.github.com",
      "RemoteUsername": "hadley",
      "RemoteRepo": "emo",
      "RemoteRef": "master",
      "RemoteSha": "3f03b11491ce3d6fc5601e210927eff73bf8e350",
      "Requirements": [
        "R",
        "assertthat",
        "crayon",
        "glue",
        "lubridate",
        "magrittr", 11





Functions

1



Functions in R
I’ve been denoting functions with parentheses: func()

We’ve seen functions such as:

mean()

tbl_summary()

init()

create_github_token

Functions take arguments and return values

2



Looking inside a function
If you want to see the code within a function, you can just
type its name without the parentheses:

usethis::create_github_token1

function (scopes = c("repo", "user", "gist", "workflow"), description = "DESCRIBE THE TOKEN'S USE 
CASE", 
   host = NULL) 
{
   scopes <- glue_collapse(scopes, ",")
   host <- get_hosturl(host %||% default_api_url())
   url <- glue("{host}/settings/tokens/new?scopes={scopes}&description={description}")
   withr::defer(view_url(url))
   hint <- code_hint_with_host("gitcreds::gitcreds_set", host)
   ui_todo("\n    Call {ui_code(hint)} to register this token in the \\\n    local Git 
credential store\n    It is also a great idea to store this token in any password-management \\\n  
software that you use")
   invisible()
}
<bytecode: 0x104c98aa0>
<environment: namespace:usethis>

3



Structure of a function

You can name your function like you do any other object

Just avoid names of existing functions

func <- function()1

4



Structure of a function

What objects/values do you need to make your function
work?

You can give them default values to use if the user
doesn’t specify others

func <- function(arg1, 1

                 arg2 = default_val)2

}3

5



Structure of a function

Everything else goes within curly braces

Code in here will essentially look like any other R code,
using any inputs to your functions

func <- function(arg1, 1

                 arg2 = default_val) {2

3

} 4

6



Structure of a function

One thing you’ll likely want to do is make new objects
along the way

These aren’t saved to your environment (i.e., you won’t
see them in the upper-right window) when you run the
function

You can think of them as being stored in a temporary
environment within the function

func <- function(arg1, 1

                 arg2 = default_val) {2

  new_val <- # do something with args 3

} 4

7



Structure of a function

Return something new that the code has produced

The return() statement is actually optional. If you don’t
put it, it will return the last object in the code. When
you’re starting out, it’s safer to always explicitly write out
what you want to return.

func <- function(arg1, 1

                 arg2 = default_val) {2

  new_val <- # do something with args3

  return(new_val)4

} 5

8



Example: a new function for the mean
Let’s say we are not satisfied with the mean() function and
want to write our own.

Here’s the general structure we’ll start with.

new_mean <- function() {1

2

}3

9



New mean: arguments
We’ll want to take the mean of a vector of numbers.

It will help to make an example of such a vector to think
about what the input might look like, and to test the
function. We’ll call it x:

We can add x as an argument to our function:

x <- c(1, 3, 5, 7, 9)1

new_mean <- function(x) {1

2

}3

10



New mean: function body
Let’s think about how we calculate a mean in math, and
then translate it into code:

So we need to sum the elements of x together, and then
divide by the number of elements.

=x
1
n ∑

i=1

n

xi

11



We can use the functions sum() and length() to help us.

We’ll write the code with our test vector first, before
inserting it into the function:

n <- length(x)1

sum(x) / n2

[1] 5

12



New mean: function body
Our code seems to be doing what we want, so let’s insert
it. To be explicit, I’ve stored the answer (within the
function) as mean_val, then returned that value.

new_mean <- function(x) {1

  n <- length(x)2

  mean_val <- sum(x) / n3

  return(mean_val)4

}5

13



Testing a function
Let’s plug in the vector that we created to test it:

And then try another one we create on the spot:

new_mean(x = x)1

[1] 5

new_mean(x = c(100, 200, 300))1

[1] 200

14



Adding another argument
Let’s say we plan to be using our new_mean() function to
calculate proportions (i.e., the mean of a binary variable).
Sometimes we’ll want to report them as as percentage by
multiplying the proportion by 100.

Let’s name our new function prop(). We’ll use the same
structure as we did with new_mean().

prop <- function(x) {1

  n <- length(x)2

  mean_val <- sum(x) / n3

15



Testing the code
Now we’ll want to test on a vector of 1’s and 0’s.

To calculate the proportion and turn it into a percentage,
we’ll just multiply the mean by 100.

x <- c(0, 1, 1)1

multiplier <- 1001

multiplier * sum(x) / length(x)2

[1] 66.66667

16



Testing the code
We want to give users the option to choose between a
proportion and a percentage. So we’ll add an argument
multiplier. When we want to just return the proportion,
we can just set multiplier to be 1.

multiplier <- 11

multiplier * sum(x) / length(x)2

[1] 0.6666667

multiplier <- 1001

multiplier * sum(x) / length(x)2

17



Adding another argument
If we add multiplier as an argument, we can refer to it in
the function body.

prop <- function(x, multiplier) {1

  n <- length(x)2

  mean_val <- multiplier * sum(x) / n3

  return(mean_val)4

}5

18



Adding another argument
Now we can test:

prop(x = c(1, 0, 1, 0), multiplier = 1)1

[1] 0.5

prop(x = c(1, 0, 1, 0), multiplier = 100)1

[1] 50

19



Making a default argument
Since we don’t want users to have to specify multiplier = 
1 every time they just want a proportion, we can set it as a
default.

Now we only need to specify that argument if we want a
percentage.

prop <- function(x, multiplier = 1) {1

  n <- length(x)2

  mean_val <- multiplier * sum(x) / n3

  return(mean_val)4

}5

prop(x = c(0, 1, 1, 1))1

[1] 0.75

prop(x = c(0, 1, 1, 1), multiplier = 100)1



[1] 75

20



Caveats
This is obviously not the best way to write this function!

For example, it will still work if x = c(123, 593, -192)….
but it certainly won’t give you a proportion or a
percentage!

We could also put multiplier = any number, and we’ll
just be multiplying the answer by that number – this is
essentially meaningless.

We also haven’t done any checking to see whether the
user is even entering numbers! We could put in better
error messages so users don’t just get an R default error
message if they do something wrong.
prop(x = c("blah", "blah", "blah"))1

21



Exercises
Create some functions!

Create an R script in your project called functions.R to
save your work!

22





{targets}

1



What is {targets}?
“a Make-like pipeline tool
for statistics and data
science in R”

manage a sequence of
computational steps

only update what needs
updating

ensure that the results at
the end of the pipeline are
still valid

2



Script-based workflow
01-data.R

02-model.R

03-plot.R

library(tidyverse)1

data <- read_csv("data.csv", col_types = cols()) %>% 2

    filter(!is.na(Ozone))3

write_rds(data, "data.rds")4

library(tidyverse)1

data <- read_rds("data.rds")2

model <- lm(Ozone ~ Temp, data) %>% 3

    coefficients()4

write_rds(model, "model.rds")5

library(tidyverse)1

model <- read_rds("model.rds")2

data <- read_rds("data.rds")3

ggplot(data) +4

    geom_point(aes(x = Temp, y = Ozone)) +5

    geom_abline(intercept = model[1], slope = model[2])6

ggsave("plot.png", plot)7
3



Problems with script-based workflow
Reproducibility: if you change something in one script,
you have to remember to re-run the scripts that depend
on it

Efficiency: that means you’ll usually rerun all the scripts
even if they don’t depend on the change

Scalability: if you have a lot of scripts, it’s hard to keep
track of which ones depend on which

File management: you have to keep track of which files
are inputs and which are outputs and where they’re
saved

Based on example in https://books.ropensci.org/targets 4

https://books.ropensci.org/targets


{targets} workflow
R/functions.R

get_data <- function(file) {1

  read_csv(file, col_types = cols()) %>%2

    filter(!is.na(Ozone))3

}4

5

fit_model <- function(data) {6

  lm(Ozone ~ Temp, data) %>%7

    coefficients()8

}9

10

plot_model <- function(model, data) {11

  ggplot(data) +12

    geom_point(aes(x = Temp, y = Ozone)) +13

geom abline(intercept = model[1] slope = model[2])14

5



{targets} workflow
_targets.R

Run tar_make() to run pipeline

library(targets)1

2

tar_source()3

tar_option_set(packages = c("tidyverse"))4

5

list(6

  tar_target(file, "data.csv", format = "file"),7

  tar_target(data, get_data(file)),8

  tar_target(model, fit_model(data)),9

  tar_target(plot, plot_model(model, data))10

)11

use_targets() will generate a _targets.R script for you to fill in. 6



{targets} workflow
Targets are “hidden” away where you don’t need to
manage them
├── _targets.R
├── data.csv
├── R/
│   ├── functions.R
├── _targets/
│   ├── objects
│          ├── data
│          ├── model
│          ├── plot

You can of course have multiple files in R/; tar_source() will source them all 7



My typical workflow with {targets}
�. Read in some data and do some cleaning until it’s in the form I want to work

with.

�. Wrap that in a function and save the file in R/.

�. Run use_targets() and edit _targets.R accordingly, so that I list the data file as a
target and clean_data as the output of the cleaning function.

�. Run tar_make().

�. Run tar_load(clean_data) so that I can work on the next step of my workflow.

�. Add the next function and corresponding target when I’ve solidified that step.

I usually include library(targets) in my project .Rprofile so that I can always call
8



_targets.R tips and tricks
list(1

  tar_target(2

    data_file,3

    "data/raw_data.csv",4

    format = "file"5

  ),6

  tar_target(7

    raw_data,8

    read.csv(data_file)9

  ),10

  tar_target(11

    clean_data,12

    clean_data_function(raw_data)13

)14

I like to pair my functions/targets by name so that the workflow is clear to me 9



_targets.R tips and tricks
preparation <- list(1

  ...,2

  tar_target(3

    clean_data,4

    clean_data_function(raw_data)5

  )6

)7

modeling <- list(8

  tar_target(9

    linear_model,10

    linear_model_function(clean_data)11

  ),12

  ...13

)14

By grouping the targets into lists, I can easily comment out chunks of the pipeline
10



_targets.R tips and tricks
## prepare ----1

prepare <- list(2

  ### cleanData.csv ----3

  tar_target(4

    cleanData.csv,5

    file.path(path_to_data, 6

              "cleanData.csv"),7

    format = "file"8

  ),9

  ### newdat ----10

  tar_target(11

    newdat,12

    read_csv(cleanData.csv, 13

guess max = 20000)14

In big projects, I comment my _targets.R file so that I can use the RStudio outline
11



Key {targets} functions
use_targets() gets you started with a _targets.R script to fill in

tar_make() runs the pipeline and saves the results in _targets/objects/

tar_make_future() runs the pipeline in parallel1

tar_load() loads the results of a target into the global environment
(e.g., tar_load(clean_data))

tar_read() reads the results of a target into the global environment
(e.g., dat <- tar_read(clean_data))

tar_visnetwork() creates a network diagram of the pipeline

tar_outdated() checks which targets need to be updated

tar_prune() deletes targets that are no longer in _targets.R

tar_destroy() deletes the .targets/ directory if you need to burn everything
down and start again

� Note: {targets} is moving to a new distributed computing strategy using {crew}
12



Advanced {targets}

14



“target factories”

15



{tarchetypes}: reports
Render documents that depend on targets loaded with
tar_load() or tar_read().

tar_render() renders an R Markdown document

tar_quarto() renders a Quarto document (or project)

It can’t detect dependencies like tar_load(ends_with("plot")) 16



What does report.qmd look like?

Because report.qmd depends on results and plots, it will
only be re-rendered if either of those targets change.

---1

title: "My report"2

---3

```{r}4

library(targets)5

tar_load(results)6

tar_load(plots)7

```8

There were `r results$n` observations with a mean age of `r result9

```{r}10

library(ggplot2)11

plots$age_plot12

```13

17



{tarchetypes}: branching
Using data from the National Longitudinal Survey of Youth,

_targets.R R/functions.R

we want to investigate the relationship between age at first birth and hours of
sleep on weekdays and weekends among moms and dads separately

library(targets)1

library(tarchetypes)2

tar_source()3

4

targets_setup <- list(5

  tar_target(6

    csv,7

    "data/nlsy.csv",8

    format = "file"9

  ),10

  tar_target(11

    dat,12

    readr::read_csv(csv, 13

      show_col_types = FALSE)14

  )15

)16

model_function <- function(outcome_var, 1

                           sex_val, dat) {2

3

  lm(as.formula(paste(outcome_var, 4

      " ~ age_bir + income + factor(region)")) ,5

     data = dat, 6

     subset = sex == sex_val)7

}8

9

coef_function <- function(model) {10

  coef(model)[["age_bir"]]11

}12

18



Option 1
Create (and name) a separate target for each combination
of sleep variable ("sleep_wkdy", "sleep_wknd") and sex
(male: 1, female: 2):

… and so on…

targets_1 <- list(1

  tar_target(2

    model_1,3

    model_function(outcome_var = "sleep_wkdy", sex_val = 1, dat = 4

  ),5

  tar_target(6

    coef_1,7

    coef_function(model_1)8

  )9

)10

19



Option 2
Use tarchetypes::tar_map() to map over the
combinations for you (static branching):

targets_2 <- tar_map(1

  values = tidyr::crossing(2

    outcome = c("sleep_wkdy", "sleep_wknd"),3

    sex = 1:24

  ),5

  tar_target(6

    model_2,7

    model_function(outcome_var = outcome, sex_val = sex, dat = dat8

  ),9

  tar_target(10

    coef_2,11

    coef_function(model_2)12

  )13

)14 20



Option 2, cont.
Use tarchetypes::tar_combine() to combine the results of
a call to tar_map():

command = vctrs::vec_c(!!!.x) is the default, but you can
supply your own function to combine the results

combined <- tar_combine(1

  combined_coefs_2,2

  targets_2[["coef_2"]],3

  command = vctrs::vec_c(!!!.x),4

)5

tar_read(combined_coefs_2)6

21



Option 3
Use the pattern = argument of tar_target() (dynamic branching):

targets_3 <- list(1

  tar_target(2

    outcome_target,3

    c("sleep_wkdy", "sleep_wknd")4

  ),5

  tar_target(6

    sex_target,7

    1:28

  ),9

  tar_target(10

    model_3,11

    model_function(outcome_var = outcome_target, sex_val = sex_tar12

    pattern = cross(outcome_target, sex_target)13

)14

22



Branching
Dynamic Static

Pipeline creates new
targets at runtime.

All targets defined in advance.

Cryptic target names. Friendly target names.

Scales to hundreds of
branches.

Does not scale as easily for
tar_visnetwork() etc.

No metaprogramming
required.

Familiarity with
metaprogramming is helpful.

From https://books.ropensci.org/targets/dynamic.html#branching 23

https://books.ropensci.org/targets/dynamic.html#branching


Branching
The book also has an example of using
metaprogramming to map over different functions

i.e. fit multiple models with the same arguments

Static and dynamic branching can be combined

e.g. tar_map(values = ..., tar_target(..., pattern 
= map(...)))

Branching can lead to slowdowns in the pipeline (see
book for suggestions)

24



{tarchetypes}: repetition
tar_rep() repeats a target multiple times with the same
arguments

The pipeline gets split into batches x reps chunks, each
with its own random seed

targets_4 <- list(1

  tar_rep(2

    bootstrap_coefs,3

    dat |>4

      dplyr::slice_sample(prop = 1, replace = TRUE) |>5

      model_function(outcome_var = "sleep_wkdy", sex_val = 1, dat 6

      coef_function(),7

    batches = 10,8

    reps = 109

  )10

)11

25



{tarchetypes}: mapping over iterations

tar_map_rep() repeats a target multiple times with
different arguments

sensitivity_scenarios <- tibble::tibble(1

  error = c("small", "medium", "large"),2

  mean = c(1, 2, 3),3

  sd = c(0.5, 0.75, 1)4

)5

targets_5 <- tar_map_rep(1

  sensitivity_analysis,2

  dat |> 3

    dplyr::mutate(sleep_wkdy = sleep_wkdy + rnorm(nrow(dat), mean,4

    model_function(outcome_var = "sleep_wkdy", sex_val = 1, dat = 5

    coef_function() |> 6

    data.frame(coef = _),7

  values = sensitivity_scenarios,8



  batches = 10,9

  reps = 1010

)11

26



{tarchetypes}: mapping over iterations

Ideal for sensitivity analyses that require multiple
iterations of the same pipeline with different parameters

tar_read(sensitivity_analysis) |> head()1

tar_read(sensitivity_analysis) |>1

  dplyr::group_by(error) |> 2

  dplyr::summarize(q25 = quantile(coef, .25),3

                   median = median(coef),4

                   q75 = quantile(coef, .75))5

27



Summary
{targets} is a great tool for managing complex
workflows

{tarchetypes} makes it even more powerful

The  is a great resource for learning moreuser manual

28
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Exercises
We’ll clone a repo with {targets} already set up and add
some additional steps to the analysis.

29




